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Rugged TROLL® 100 and 200 Operator's Manual
The Rugged TROLL 100 and 200 instruments are designed to 
measure pressure, level, and temperature in natural groundwater 
and surface water. They also can be used at industrial sites, landfills, 
and other installations. 

Both instruments have completely sealed bodies that contain an 
absolute (non-vented) pressure sensor, temperature sensor, real-
time clock, microprocessor, lithium battery, and internal memory.

The Rugged TROLL 100 is designed to hang by a backshell hanger 
from a suspension wire. The Rugged TROLL 200 can utilize the 
backshell hanger or can connect to a cable for easy top-of-well 
RS485 communications via RuggedReader® Handheld PC or laptop 
PC. Additionally, Rugged TROLL 200 cables with stripped-and-
tinned cable ends can communicate with data loggers, TROLL® Link 
Telemetry Systems, or PLC devices via RS485 or SDI-12.

COMMUNICATION ACCESSORIES
•	 USB or RS232 docking station for the Rugged TROLL 100 and 

200 Instruments

•	 USB or RS232 Rugged TROLL® Com for the Rugged TROLL 200 and 
Rugged BaroTROLL® Instruments

•	 Win-Situ® 5 Software for programming and downloading

•	 Optional software: Win-Situ® Baro Merge™ for barometric 
compensation; Win-Situ® Mobile for the RuggedReader 
Handheld PC; Win-Situ® Sync to transfer downloaded data logs 
from a RuggedReader to a laptop/desktop PC

OTHER ACCESSORIES
•	 Rugged TROLL 100 — suspension cable; RuggedReader 

Handheld PC; Rugged BaroTROLL for logging barometric 
pressure data

•	 Rugged TROLL 200 — suspension cable; RuggedReader device; 
Rugged BaroTROLL for logging barometric pressure data; SDI-12 
compatible cable with stripped-and-tinned uphole termination; 
RS485 compatible cable with stripped-and-tinned uphole 
termination; or Modbus/RS485 top-of-well cable

•	 Rugged TROLL 200 cable suspension kit: Use this to create a 
weight-bearing loop capable of suspending up to 100 lbs (45.4 kg) 
of cable and instrument

GETTING STARTED
You will need:

•	 Rugged TROLL 100 or 200 Instrument
•	 USB or RS232 docking station or Rugged TROLL Com (for 

Rugged TROLL 200 and Rugged BaroTROLL). RS232 model 
needed for connection to a RuggedReader device.

•	 In-Situ Software/Resource CD or Internet connection 
•	 Desktop / laptop PC or RuggedReader Handheld PC

A.	 Install software from the In-Situ Software CD or 
www.in-situ.com.

1.	 Win-Situ 5 Software (version 5.6.16.0 or higher)

•	 Click the Win-Situ 5 link and follow the instructions. 

•	 For a USB docking station, be sure to select the “Install USB 
Drivers” option.

2.	 Win-Situ Mobile Software (for the RuggedReader)

•	 Click the Win-Situ Mobile link and follow the instructions to 
install Win-Situ® Software Manager (desktop component of Win-
Situ Mobile). 

•	 If running Windows® XP or earlier, also install Microsoft® 
ActiveSync® 4.5 or higher. For Windows® Vista or Windows® 
7, download and install the Windows® Mobile Device Center 
software to communicate with the RuggedReader unit.

•	 To install Win-Situ Mobile on the RuggedReader: connect the 
RuggedReader to the PC via USB cable; establish a connection 
via ActiveSync; launch the Win-Situ Software Manager; click 
Win-Situ Mobile; click Install. Be sure to have your In-Situ Software 
License Certificate available.

3.	 Win-Situ Baro Merge Software 

•	 Install Baro Merge Software if you plan to post-correct level data 
to compensate for barometric pressure.

4.	 Win-Situ Sync Software

•	 Install Win-Situ Sync if you want to automatically transfer 
downloaded log files from a RuggedReader to a PC. 

B.	 Connect to the Rugged TROLL Docking Station  
(Rugged TROLL 100 or 200) 

•	 Unscrew and remove the 
hanger from the Rugged 
TROLL instrument. 

•	 Invert the instrument. 
Align the notch on the 
Rugged TROLL body with 
the tab on the rim of the 
docking station to ensure 
the pins are in contact for 
communication. 

•	 Place the Rugged TROLL into 
the docking station. 

•	 Connect the docking station cable to the computer.

TIP: The hanger is the only removable part of the Rugged TROLL 
Instrument. Do not attempt to take the instrument apart. There are no 
user-serviceable parts in the instrument. 
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C.	 Connect to the Rugged TROLL Com (Rugged 
TROLL 200 and Rugged BaroTROLL)

•	 Refer to the Rugged TROLL Com communication device 
instruction sheet.

TIP: The Rugged TROLL Com requires a minimum of 8 VDC. If you lose 
connection to your instrument, particularly over long cable distances, 
replace the Rugged TROLL Com battery.

D.	 SDI-12 Wire Connections (stripped-and-tinned only)
•	 Black = ground
•	 Red = 12 V supply line
•	 Blue = serial data line

Remaining wires should be terminated (grounded) at the data 
recorder. For more information, refer to the Rugged TROLL 200 
cable instruction sheet.

E.	 RS485 Wire Connections (stripped-and-tinned only)
•	 Black = ground
•	 Red = 12 V supply line
•	 Blue = RS485 (+)
•	 Green = RS485 (-)

Remaining wires should be terminated (grounded) at the data 
recorder.

Fig. 1. Win-Situ Data tab on first connection Fig. 2. Home tab with device readings

PROGRAMMING THE RUGGED TROLL 100 OR 200

A.	 Open the Software 

1.	 Start Win-Situ by double-clicking the desktop shortcut . 
Win-Situ opens at the Data tab, shown in Fig. 1.

2.	 When you use the software for the first time, the software 
may ask if you want to select a COM port. Do one of the 
following:

•	 Answer Yes to the prompt, then check or change the port in the 
Preferences > Comm Settings dialog, and click OK  to 
close it.

•	 Answer No to bypass this step.

The Win-Situ default is COM 1. For USB communication, be sure to 
select the correct COM port. See the sidebar.

3.	 Win-Situ asks if you want to connect to the device. If the 
Rugged TROLL is connected to your computer as shown 
above, answer Yes. 

4.	 The software will connect and display a reading of all 
supported parameters in the Home tab (Fig. 2).

B.	 Set the Clock
Data collection schedules depend on the device clock, shown with 
the system (PC) clock near the top of the screen when connected 
(Fig. 2). If the device clock is red, synchronize it to the system clock 
by clicking the Clock Sync button (Fig. 2).

C.	 Create a Site
Logged Rugged TROLL data are organized by the site where the 
data were logged. You will need a site when setting up a data log. 
Follow the steps below to create a new site: 

•	 On the Data tab, click the Site Data folder (Fig. 1).

•	 Select File menu > New > Site. 

•	 Enter a short, descriptive name—for example, a project, well, 
river, gaging station, town, nearby landmark, etc. (max: 32 
characters).  

•	 Enter any additional options you want, and then click Save  

. 

•	 To set the new site in the Rugged TROLL: Return to the Home tab, click 
the down arrow beside the site box (Fig. 2), and select the new site. 

Which USB Port Am I Using?

When a USB Docking Station is connected, the drivers that were 
downloaded with Win-Situ 5 are installed. After installation, 
check which COM port the connected USB Docking Station is 
using:

•	 Windows® 2000, Windows XP: Control Panel > System > 
Hardware tab > Device Manager > Ports. Click the plus sign 
to display the ports.

•	 Windows Vista: Control Panel > System > Device Manager 
(User permission required) > Ports. Click the plus sign to display 
the ports.

•	 Windows 7: Control Panel > System > Device Manager > Ports.  
Click the arrow to display the ports.

Remember the USB Serial Port COM number. You will need it to 
connect to the instrument with Win-Situ Software.

C:\Documents and Settings\[Login]\My Documents\WinSitu Data\

2 Check the 
COM port

3 Connect to the 
Rugged TROLL 100

Data tab

Site Data folder

Device is connected 

Home tab

Clock sync

Site box

Device  
is not  

connected
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D.	 Set up a Data Log

•	 Click the Logging tab  .

•	 Click the “New” button   at the bottom of the Logging 
screen.

The Logging Setup Wizard will prompt you through the 
configuration of a data log. For details, refer to the Win-Situ Help 
menu. 

 TIP:  When logging Level (DTW or Surface), select the option “Set First 
Logged Reading to____” for the Level Reference.  Be sure to select a 

Scheduled start, so the log will start automatically.

 TIP:  When logging, choose a Scheduled start, or start the log before 

disconnecting by selecting it in the Logging tab and clicking “Start” .

E. Disconnect and Deploy the Instrument
•	 Click the Disconnect button.

•	 Exit the software (File menu > Exit). 

•	 Remove the Rugged TROLL from the docking station or Rugged 
TROLL Com. 

•	 Connect to the backshell hanger and wire to the cable.  Be sure 
to replace the cover for the top-of-well connector.

•	 Install the device in the field location.

TIP: A Scheduled log will start at its programmed start time only if the 
device clock is correctly set (see page 2).

WARNING: Tighten the backshell hanger only until it is hand tight. DO 
NOT use tools to secure the backshell hanger to the instrument. Over tightening 
will damage the instrument.

DOWNLOADING THE LOGGED DATA
•	 Retrieve the Rugged TROLL 100 by pulling up the suspension 

cable. Dry the instrument and remove the hanger. Place the 
Rugged TROLL 100 in the docking station (see page 1) and 
establish a software connection.

•	 For the Rugged TROLL 200, remove the cap from the cable and 
attach the Rugged TROLL Com. Connect the Rugged TROLL 
Com to a PC or RuggedReader device and establish a software 
connection.

•	 Click the Logging tab  and then the log. The symbol  
shows the log is running. If the log stopped on schedule, the symbol 

is .

TIP:  It is not necessary to stop the log before downloading, but if you 

want the device to stop logging, press “Stop” .

•	 To download, press the “Download” button  and 
select a download option. The log will be copied to the PC or 
RuggedReader device.

TIP: Use Win-Situ Sync to transfer downloaded logs from a 
RuggedReader to a desktop or laptop PC running Win-Situ. This will 

ensure that the logs are placed in the Win-Situ working directory. 

Pressure due to  
atmosphere + 
water column 

(measured by 
Rugged TROLL)

Water 
Level

Pressure  
due to  
water 

column 
(calculated 

by  
subtracting 

Rugged 
BaroTROLL  

data from  
Rugged 

TROLL data)

Pressure  
due to  
atmosphere 
(measured 
by Rugged 
BaroTROLL )

Rugged BaroTROLL

Rugged TROLL

Fig. 3. Rugged BaroTROLL & Rugged TROLL deployment

RUGGED BARO TROLL INSTRUMENT
The Rugged BaroTROLL measures and logs barometric pressure 
and temperature in air. This data can be used to correct the Rugged 
TROLL 100 and 200 data by compensating for barometric pressure 
effects during the course of a log. 

Programming the Rugged BaroTROLL
•	 Connect as you would for the Rugged TROLL instrument.
•	 Program as you would for the Rugged TROLL. Be sure to sync 

the clock. The Baro TROLL measurements can be taken quite far 
apart as long as they cover the same general time period as the 
Rugged TROLL log. 

•	 If the Rugged TROLL log used a reference (“Set first logged 
reading to”), the Rugged BaroTROLL log should start before the 
Rugged TROLL log to ensure barometric pressure at the time of 
the first reading is captured.

•	 Disconnect, attach the hanger, and deploy the instrument 
suspended or lying in a protected location above water level, 
near the submerged Rugged TROLL 100 or 200. One possibility 
is shown in Fig. 3. 

DO NOT submerge a Rugged BaroTROLL instrument.

•	 Download data as you would for the Rugged TROLL 100 and 200. 
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CORRECTING FOR BAROMETRIC PRESSURE
As shown in Fig. 3, the Rugged TROLL 100 and 200 instruments 
measure all pressure forces detected by their absolute pressure 
sensors. These forces include barometric (also called atmospheric) 
pressure and the pressure of the water above the sensor. As a 
result, logged data will show the effects of changes in barometric 
pressure. These effects can be removed manually (see the technical 
note “Manual Barometric Correction” in the Technical Resources 
section of the In-Situ website). To automatically remove barometric 
pressure effects, use Win-Situ Baro Merge software to post correct 
non-vented water level data. 

Using Baro Merge Software
You will need: 

•	 Win-Situ Baro Merge and Win-Situ 5 installed on a desktop/
laptop PC

•	 One or more Rugged TROLL logs in your Win-Situ working 
directory

•	 A Rugged BaroTROLL log in your Win-Situ working directory 
covering the time period of the Rugged TROLL log(s) to be 
corrected

1.	 Launch Baro Merge from the desktop shortcut or the 
Win‑Situ 5 Tools menu.

2.	 In the main window, select “Use a BaroTROLL file” for the 
compensation method (Fig. 4). 

TIP: Information on the other two compensation methods may be 
found in Baro Merge Help (press F1 in Baro Merge).

Fig 4. Baro Merge options with BaroTROLL file method selected

3.	 	Click   to select a Rugged BaroTROLL log file. (Baro 
Merge displays these automatically by site when they are in 
the proper location.) 

•	 Click the plus sign to expand the site and display the logs. 
•	 Check  the Rugged BaroTROLL file you want to use, then 

click OK  . 
4.	 The main window returns to the screen with the Rugged 

BaroTROLL log file displayed (Fig. 4). Click Next  to 
continue.  

5.	 Baro Merge reads and displays the values in the Rugged 
BaroTROLL log. Edit the values if necessary, or click Next 

 to continue. 

TIP: For details on adding or editing values and time stamps in the table, 
see Baro Merge Help (search for “Manual Entry”) .

6.	 	Now choose the Rugged TROLL log file(s) you intend to 
correct  (shown automatically when in the proper location). 

•	 You may check R as many files as you like. For best results 
the time stamps in the Rugged BaroTROLL log and the 
Rugged TROLL log(s) should overlap. (Baro Merge will use 
the first and last barometric values for Rugged TROLL data 
points beyond the barometric data time stamps.)

7.	 	Click OK  . The barometric compensation is applied. 
When processing is complete, click OK again.

8.	 	Click   to close Baro Merge. 

•	 	The compensated log files may be viewed or exported from 
the Data tab in Win-Situ. The original Rugged TROLL log file 
is not changed. A corrected log file with the same name and 
path is created with the file extension “–BaroMerge.wsl.” 

•	 For more information, refer to the Win-Situ Baro Merge 
technical note at www.in-situ.com.

Warranty Provisions
In-Situ Inc. warrants the Rugged TROLL 100 and 200 and Rugged 
BaroTROLL for one (1) year, from the factory ship date, against defects 
in materials and workmanship under normal operating conditions. 
Complete warranty provisions are posted on our web site (www.
in-situ.com).

How to Contact Us
Technical Support:	 800 446 7488, option 3
(Toll-free 24 hours a day in the U.S. and Canada)
Mailing/Shipping Address:	 In-Situ Inc.
	 221 East Lincoln Ave.
	 Fort Collins, CO 80524
	 U.S.A.
Phone:	 970 498 1500
Fax:	 970 498 1598
Internet:	 www.in-situ.com
Email:	 support@in-situ.com

To Obtain Repair Service (U.S.A.)
If you suspect that your Rugged TROLL 100/200 or Rugged 
BaroTROLL is malfunctioning and repair is required, you can help 
assure efficient servicing by following these guidelines: 

•	 Call or email In-Situ Technical Support (support@in-situ.com). 
Have the equipment with you when you call.

•	 Be prepared to describe the problem, including how the 
instrument was being used and the conditions noted at the time 
of the malfunction. 

•	 If Technical Support determines that service is needed, they 
will ask that you download and complete a Return Materials 
Authorization form available on the In-Situ website under 
Contact/Returns for Service.

•	 Clean the instrument and/or cable. Decontaminate thoroughly if it 
has been used in a toxic or hazardous environment.  

•	 Carefully pack the instrument and/or cable in a suitable shipping box. 
•	 Mark the RMA number clearly on the outside of the box with a 

marker or label.
•	 Send the package, shipping prepaid, to ATTN: RMA #XXXXX, at the 

address above.
The warranty does not cover damage during transit. We recommend 
the customer insure all shipments. Warranty repairs will be shipped 
back prepaid.

Outside the U.S.A.
Contact your international In-Situ distributor for repair and service 
information.



﻿	 Page 5 

Operational Temp. Range1 0 to 50° C (32 to 122° F)

Storage Temp. Range -40 to 80° C (-40 to 176° F)

Calibrated Temp. Range 0 to 50°C (32 to 122° F)

Diameter 2.62 cm (1.03 in) OD

Length 14.43 cm (5.68 in)

Weight 170 g (0.37 lb)

Materials Titanium body; Delrin® nose 
cone, hanger, backend

Output Options Rugged TROLL 100: USB or 
RS232 via docking station

Rugged TROLL 200: USB or 
RS232 via docking station; 
Modbus/RS485 or SDI-12 via 
Rugged TROLL 200 cable

Battery Type 3.6 V lithium internal battery

Battery Life Typical 10 years or 2M 
readings1

External Power Rugged TROLL 100: NA 
Rugged TROLL 200: 8-36 VDC

Measurement Current 14 mA typical

Idle Current (network activity only) 200 µA typical

Sleep Current (no network activity) 20 µA typical

Memory 1.0 MB

Data Records 
     Date/time + 1 parameter 
     Date/time + 2 parameters 
     Date/time + 3 parameters

 
94,5002 
65,0002 
49,5002

Number of logs supported Rugged TROLL 100: 1 log 
Rugged TROLL 200: 2 logs

Fastest Logging Rate 1 per second

Fastest Output Rate Rugged TROLL 200 only 
Modbus & SDI-12: 1 per second

Log Types Linear, Fast Linear, Event

Suspension Cable (use with 
backshell hanger & Rugged 
TROLL 100/200 or Rugged 
BaroTROLL)

Poly-coated 304 stainless steel 
50 ft, 150 ft, 300 ft (15.24 m, 
45.72 m, 91.44 m)

Rugged TROLL 200 Cable (use 
with Rugged TROLL 200 & 
Rugged BaroTROLL)

24/4 AWG 
RS485 with connector, 
RS485 stripped and tinned 
Customizable up to 300 m 
(1000 ft) 
SDI-12 stripped and tinned 
Standard lengths up to 60 m 
(200 ft)

Rugged BaroTROLL Range: 7.0 to 30.0 psi (0.5 to 2 
bar, 0.5 to 2 atm, 14.25 to 61 
in Hg)

Docking Station  
(Rugged TROLL 100/200 & 
Rugged BaroTROLL)

USB or RS232

Rugged TROLL Com  
(use with Rugged TROLL 200 & 
 Rugged BaroTROLL)

USB or RS232 for RS485 
communications via RS485 
cable with connector

Minimum System Requirements 

Win-Situ 5 (v5.6.16.0 or higher): 400 MHz Intel® Pentium® II 
processor; 128 MB RAM, 100 MB free disk space; Microsoft® Internet 
Explorer® 6.01 or higher; Windows 2000 Professional SP4 or higher; 
Windows XP Professional SP2 or higher; Windows Vista or Windows 
7; CD-ROM drive; RS232 serial port or USB port

Win-Situ Mobile: RuggedReader with Microsoft Windows Mobile® 

operating system; at least 16 MB data storage memory (SD/CF 
card or built-in non-volatile memory); Microsoft ActiveSync v. 4.5 
or higher for Windows 2000/Windows XP. For Windows 7, download 
and installation of the Windows Mobile Device Center software is 
required for communication with the RuggedReader Handheld PC. 

Pressure Sensor  Type/Material 
(Non-Vented)

Piezoresistive; Ceramic

	 Range 9.0 m (30 ft) (Burst: 60 ft) 
30 m (100 ft) (Burst: 134 ft) 
76 m (250 ft) (Burst: 368 ft)

	 Accuracy at 15° C 3 Typical ± 0.1% full scale (FS)

	 Accuracy (FS)4 ± 0.3% FS max.

	 Resolution ± 0.01% FS or better

	 Units of Measure 
		  Pressure 
		  Level

 
psi, kPa, bar, mbar, mmHg, 
in, ft, mm, cm, m

Temperature Sensor Silicon

	 Range Calibrated: 32 to 122° F (0 to 
50° C)

	 Accuracy ± 0.3° C

	 Resolution 0.01° C or better

	 Units of measure Celsius or Fahrenheit 

1 When used within the factory-calibrated temperature range
2 Data logged (no wrapping) from device within the factory- 
calibrated temperature range
3 Across factory-calibrated pressure range
4 Across factory-calibrated pressure and temperature ranges

Specifications are subject to change without notice. Delrin is a 
registered trademark of E.I. du Pont de Nemours & Co.

RUGGED TROLL 100 AND 200 SPECIFICATIONS



In-Situ and the In-Situ Inc. logo, Baro Merge, BaroTROLL, HERMIT, RDO, RuggedCable, Pocket-Situ, RuggedReader, TROLL, and Win-Situ are trademarks or registered trademarks of 
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For more information, contact In-Situ Inc. 
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1-970-498-1500 (international & domestic)
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Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Rugged TROLL
Model: Rugged TROLL 100
Product Description: The Rugged TROLL measures and logs level and temperature in natural

groundwater and surface water.

is in compliance with the following Directives:

89/336/EEC for Electromagnetic Compatibility (EMC) Directive
73/23/EEC for Safety Directive

and meets or exceeds the following international requirements and compliance standards:

• Immunity
EN 61326:1997, Including Amendments A1:1998, A2:2001, A3:2003,
Electric Equipment for Measurement, Control and Laboratory Use

• Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control
and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Date of Issue: April 26, 2010

Signature:
Name: Bruce Barker
Title: Director of New Product Development

Declaration of Conformity

Manufacturer: In-Situ, Inc.
221 East Lincoln Avenue
Fort Collins, CO 80524
USA

Declares that the following product:

Product name: Rugged TROLL
Model: Rugged TROLL 200
Product Description: The Rugged TROLL measures and logs level and temperature in natural

groundwater and surface water.

is in compliance with the following Directives:

89/336/EEC for Electromagnetic Compatibility (EMC) Directive
73/23/EEC for Safety Directive

and meets or exceeds the following international requirements and compliance standards:

• Immunity
EN 61326:1997, Including Amendments A1:1998, A2:2001, A3:2003,
Electric Equipment for Measurement, Control and Laboratory Use

• Emissions
Class A requirements of EN 61326:1997, Electric Equipment for Measurement, Control
and Laboratory Use

Supplementary Information:
The device complies with the requirements of the EU Directives 89/336/EEC and 73/23/EEC, and the CE
mark is affixed accordingly.

Date of Issue: April 26, 2010

Signature:
Name: Bruce Barker
Title: Director of New Product Development


